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Chapter 1 — General Information

1-1 Introduction
The Spectrum Master MS2711E User Guide is part of a set of manuals that cover all of the 
instrument functions and their use. This manual covers the instrument overview, system 
functions, and other common features, along with a brief guide to basic measurement 
concepts and setups. Most instrument operations and modes are covered in specific 
measurement guides as listed below.

Additional Documentation

1-2 Contacting Anritsu
To contact Anritsu, follow the link www.anritsu.com/contact-us and select the services in your 
region.

Document Part Number Description (Required Option)
10100-00065 Important Product Information, Compliance and Safety Notices

10580-00349

Spectrum Analyzer Measurement Guide
Spectrum Analyzer
PIM Hunting
Preamplifier (Option 8)
Interference Analyzer (Option 25)
Channel Scanner (Option 27)
EMF Measurements (Option 444)
AM/FM/PM Analyzer (Option 509)

10580-00240
Power Meter Measurement Guide
High-Accuracy Power Meter (Option 19)
Power Meter (Option 29)

11410-00597 Spectrum Master Technical Data Sheet
Performance Specifications

10580-00339
E-Series Tracking Generator 
Measurement Guide
Tracking Generator (Option 20)

10580-00256 Spectrum Master Programming Manual
SCPI Programming Instruction

10580-00254 Spectrum Master Maintenance Manual
Maintenance Manual

10580-00455 EMF Measurement Guide (Option 444)

http://www.anritsu.com/contact-us
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1-3 Product Information, Compliance, and Safety
Read the Handheld Instruments Product Information, Compliance, and Safety Guide 
(PN: 10100-00065) for important safety, legal, and regulatory notices before operating the 
equipment. For additional information and literature on your product, visit the product page 
of your instrument and select the Library tab: 
http://www.anritsu.com/en-US/test-measurement/products/ms2711e

1-4 Instrument Description
The Spectrum Master MS2711E is an integrated multi-functional test instrument that 
eliminates the need to carry and learn multiple test sets. The Spectrum Master can be 
configured to include: spectrum analyzer, interference analyzer with interference mapping 
capabilities, tracking generator, channel scanner, power meter, high accuracy power meter, 
and an AM/FM/PM analyzer. A GPS receiver can be added to the MS2711E Spectrum Master 
model.

The bright 8.4 inch TFT color display provides easy viewing in a variety of lighting conditions. 
The MS2711E model is equipped with a Li-Ion battery delivering more than three hours of 
battery life. The combination of a touch screen and keypad enables users to navigate menus 
with the touch screen and enter numbers with the keypad.

The internal memory is large enough to store approximately 2,000 traces or setups. 
Measurements and setups can also be stored in a USB flash drive or transferred to a PC using 
the included USB cable. 

Available Options
Available options for the Spectrum Master MS2711E model is shown in Table 1-1.

Note

Not all USB drives are compatible with the instrument. Many drives come with a 
second partition that contains proprietary firmware. This partition must be 
removed. Only one partition is allowed. Refer to the individual manufacturer for 
instructions on how to remove it. Some drives can be made to work by reformatting 
them using the FAT32 format.

Table 1-1. Available Options (Sheet 1 of 2)

Option Number Description

MS2711E-0031 GPS Receiver (Requires GPS Antenna)
MS2711E-0019 High-Accuracy Power Meter (Requires External Power Sensor)
MS2711E-0029 Power Meter

MS2711E-0020 Tracking Generator

MS2711E-0008 Preamplifier

MS2711E-0025 Interference Analyzer(1)

MS2711E-0027 Channel Scanner

http://www.anritsu.com/en-US/test-measurement/products/ms2711e
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1. Requires Option 31.

1-5 Instrument Care and Preventive Maintenance
Site Master care and preventive maintenance consists of cleaning the unit and inspecting and 
cleaning the RF connectors on the instrument and all accessories. Clean the Site Master with 
a soft, lint-free cloth dampened with water or water and a mild cleaning solution.

Connector Care
Clean the RF connectors and center pins with a cotton swab dampened with denatured 
alcohol. Visually inspect the connectors. The fingers of the N(f) connectors and the pins of the 
N(m) connectors should be unbroken and uniform in appearance. If you are unsure whether 
the connectors are undamaged, gauge the connectors to confirm that the dimensions are 
correct. Visually inspect the test port cable(s). The test port cable should be uniform in 
appearance, and not stretched, kinked, dented, or broken.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
Type-N connectors. The recommended torque is 12 lbf·in to 15 lbf·in (1.36 N·m to 1.70 N·m). 
Inadequate torque settings can affect measurement accuracy. Over-tightening connectors can 
damage the cable, the connector, the instrument, or all of these items.

Visually inspect connectors for general wear, cleanliness, and for damage such as bent pins or 
connector rings. Repair or replace damaged connectors immediately. Dirty connectors can 
limit the accuracy of your measurements. Damaged connectors can harm the instrument. 
Connection of cables carrying an electrostatic potential, excess power, or excess voltage can 
damage the connector, the instrument, or both.

Connecting Procedure
1. Carefully align the connectors. The male connector center pin must slip concentrically 

into the contact fingers of the female connector.

2. Push connectors straight together. Do not twist or screw them together. A slight 
resistance can usually be felt as the center conductors mate.

3. To tighten, turn the connector nut, not the connector body. Major damage can occur to 
the center conductor and to the outer conductor if the connector body is twisted.

4. If you use a torque wrench, initially tighten by hand so that approximately 1/8 turn or 
45 degrees of rotation remains for the final tightening with the torque wrench.

MS2711E-0509 AM/FM/PM Analyzer

MS2711E-0098 Standard Calibration (ANSI 2540-1-1994)
MS2711E-0099 Premium Calibration to Z540 plus test data

MS2711E-0444 EMF Measurement (Requires Anritsu Isotropic Antenna)

Caution To avoid damaging the display or case, do not use solvents or abrasive cleaners.

Table 1-1. Available Options (Sheet 2 of 2)

Option Number Description
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Relieve any side pressure on the connection (such as from long or heavy cables) in order 
to assure consistent torque. Use an open-end wrench to keep the connector body from 
turning while tightening with the torque wrench.

Do not over-torque the connector.

Disconnecting Procedure 
1. If a wrench is needed, use an open-end wrench to keep the connector body from turning 

while loosening with a second wrench.

2. Complete the disconnection by hand, turning only the connector nut.

3. Pull the connectors straight apart without twisting or bending.

ESD Caution
The Spectrum Master, like other high performance instruments, is susceptible to electrostatic 
discharge (ESD) damage. Coaxial cables and antennas often build up a static charge, which 
(if allowed to discharge by connecting directly to the Spectrum Master without discharging 
the static charge) may damage the Spectrum Master input circuitry. Spectrum Master 
operators must be aware of the potential for ESD damage and take all necessary precautions. 

Operators should exercise practices outlined within industry standards such as JEDEC-625 
(EIA-625), MIL-HDBK-263, and MIL-STD-1686, which pertain to ESD and ESDS devices, 
equipment, and practices. Because these apply to the Spectrum Master, it is recommended 
that any static charges that may be present be dissipated before connecting coaxial cables or 
antennas to the Spectrum Master. This may be as simple as temporarily attaching a short or 
load device to the cable or antenna prior to attaching to the Spectrum Master. It is important 
to remember that the operator may also carry a static charge that can cause damage. 
Following the practices outlined in the above standards will ensure a safe environment for 
both personnel and equipment.

RF Input Warning
The Anritsu Spectrum Master is a sensitive measuring instrument designed to measure low 
power levels. Avoid damaging this sensitive circuitry by observing the maximum input levels 
printed on the instrument connector labeling and specified in the product technical data 
sheet.

Typical maximum input is +33 dBm (±50 VDC) and could be less if additional features, such 
as a preamplifier, are in use. Be sure to review the product technical data sheet or Anritsu 
website for recommended components and accessories that can help you protect your 
instrument. These include a variety of adapters, attenuators, filters, and RF detection 
accessories.
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Battery Replacement
The battery can be replaced without the use of tools. The battery compartment is located 
on the lower left side of the instrument (when you are facing the measurement display). 
To remove the battery:

1. Slide the catch toward the bottom of the instrument.

2. Pull the top of the door away from the unit.

3. Lift out the battery door.

4. Remove the battery pack from the instrument by grabbing the battery lanyard and 
pulling out.

Replacement is the opposite of removal. The battery key side (slot below the contacts) should 
be facing the front of the unit and slide in first. 

The battery that is supplied with the Spectrum Master may need charging before use. The 
battery can be charged while it is installed in the Spectrum Master by using either the 
AC-DC Adapter or the DC adapter, or outside the Spectrum Master with the optional 
Dual Battery Charger. Refer to “Symbols and Indicators” on page 2-8 for a description of 
battery symbols.

Note
When inserting the battery, the battery label should face the back of the instrument 
and the guide slot on the battery should be below the contacts. If the battery door 
does not latch closed, the battery may be inserted incorrectly.

Figure 1-1. Battery Compartment Door
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1-6 Calibration and Verification
Anritsu recommends an annual calibration and performance verification of the 
Spectrum Master by a local Anritsu service center. The Spectrum Master is self-calibrating 
and there are no field-adjustable components. Contact information for Anritsu Service 
Centers is available at http://www.anritsu.com/contact-us.

1-7 Secure Environment Workplace
This section details the types of memory in the Spectrum Master, how to delete stored user 
files in internal memory, and recommended usage in a secure environment workplace.

Spectrum Master Memory Types: The instrument contains non-volatile disk-on-a-chip 
memory, EEPROM, and volatile DRAM memory. The instrument is also supplied with an 
external USB flash drive. The instrument does not have a hard disk drive or any other type of 
volatile or non-volatile memory.

Disk-On-A-Chip (DOC): DOC is used for storage of instrument firmware, factory calibration 
information, user measurements, setups, and .jpg screen images. User information stored on 
the DOC is erased by the master reset process described below.

EEPROM: This memory stores the model number, serial number, and calibration data for the 
instrument. Also stored here are the user-set operating parameters such as frequency range. 
During the master reset process all operating parameter stored in the EEPROM are set to 
standard factory default values.

RAM Memory: This is volatile memory used to store parameters needed for the normal 
operation of the instrument along with current measurements. This memory is reset 
whenever the instrument is restarted.

External USB Flash Drive (not included with the instrument): This memory may be selected 
as the destination for saved measurements and setups for the instrument. The user can also 
copy the contents of the internal disk-on-chip memory to the external flash memory for 
storage or data transfer. The external Flash USB can be reformatted or sanitized using 
software on a PC.

Refer to the Chapter 4, “File Management” for additional information on saving and copying 
files to the USB flash drive.

Note
Use only Anritsu Company approved batteries, adapters, and chargers with this 
instrument. Anritsu Company recommends removing the battery for long-term 
storage of the instrument.

Caution

When using the Automotive Cigarette Lighter Adapter, always verify that the 
supply is rated for a minimum of 60 Watts @ 12 VDC, and that the socket is clear 
of any dirt or debris. If the adapter plug becomes hot to the touch during operation, 
discontinue use immediately.

http://www.anritsu.com/contact-us
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Erase All User Files in Internal Memory
Perform a Master Reset:

1. Turn the instrument on.

2. Press the Shift button then the System (8) button.

3. Press the System Options submenu key.

4. Press the Reset key, then the Master Reset key.

5. A dialog box will be displayed on the screen warning that all settings will be returned to 
factory default values and all user files will be deleted. This deletion is a standard file 
delete and does not involve overwriting exiting information.

6. Press the ENTER button to complete the master reset.

7. The instrument will reboot and the reset is complete.

Recommended Usage in a Secure Environment
Set the Spectrum Master to save files to the external USB Flash drive:

1. Attach the external Flash drive and turn the instrument on.

2. Press the Shift button then the File (7) button.

3. Press the Save submenu key.

4. Press the Change Save Location submenu key, then select the USB drive with the 
rotary knob, Up/Down arrow keys, or the touchscreen.

5. Press the Set Location submenu key.

The external USB drive is now the default location for saving files.

Note

Not all USB drives are compatible with the instrument. Many drives come with a 
second partition that contains proprietary firmware. This partition must be 
removed. Only one partition is allowed. Refer to the individual manufacturer for 
instructions on how to remove it. Some drives can be made to work by reformatting 
them using the FAT32 format.
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Chapter 2 — Instrument Overview 

2-1 Introduction
This chapter provides an overview of the Anritsu Spectrum Master. It describes the 
instrument front panel, touch screen display, and the connector panel. For detailed 
information on the instrument’s test and measurement functions, refer to one of the Anritsu 
user documents listed in Appendix A, “Measurement Guides”. 

2-2 Turning On the Spectrum Master
The Anritsu Spectrum Master is capable of approximately three hours of continuous 
operation from a fully charged, field-replaceable battery (refer to “Battery Replacement” 
on page 1-5). The Spectrum Master can also be operated from a 12 VDC source (which will 
simultaneously charge the battery). This can be achieved with either the Anritsu AC-DC 
Adapter or the Automotive Power Adapter. Both items are included as standard accessories 
with the Spectrum Master. Refer to the instrument Technical Data Sheet. 

To turn on the Spectrum Master, press the green On/Off button on the front panel (see 
Figure 2-1 on page 2-2).

The Spectrum Master takes approximately 60 seconds to complete power-up and to load the 
application software. At the completion of this process, the instrument is ready for use. 

Caution

When using the Automotive Power Adapter, always verify that the supply is rated 
for a minimum of 60 Watts @ 12 VDC, and that the socket is clear of any dirt or 
debris. If the adapter plug becomes hot to the touch during operation, discontinue 
use immediately. 

Note Keep the fan inlet and exhaust ports clear of obstructions at all times for proper 
ventilation and cooling of the instrument.
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2-3 Instrument Front Panel
The Spectrum Master uses a touch screen and keypad for data input. See Figure 2-1. The five 
bottom menu keys and up to eight submenu keys on the right side of the display are touch 
screen keys. The menu and submenu keys vary depending on the current measurement mode, 
installed options, and instrument function selected. 

LED Indicators

Power LED
The Power LED is located on the left of the On/Off button. The LED is solid green when the 
instrument is on, and blinks slowly when the unit is off but is connected to an external power 
source.

Charge LED
The Charge LED is located on the right of the On/Off button. The LED blinks slowly when the 
battery is charging and is solid green when the battery is fully charged.

Figure 2-1. Spectrum Master Front Panel and Interface Screen
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Front Panel Keys
The numeric keypad, rotary knob, and the four arrow keys can all be used to change the value 
of the currently selected parameter.

Numeric Keypad
Keys 0 through 9 are used for numeric input, with an alternate function printed in blue above 
each of the keys. Press the Shift key, then a numeric key, to access the instrument menu or 
function indicated by the key label.

Some of the alternate functions associated with the numeric keypad are not available in all 
measurement modes. Refer to the Measurement Guides listed in Appendix A.

Shift Key
Pressing the Shift key followed by a number key executes the function that is indicated in 
blue above the number key. When the Shift key is active, its icon is displayed at the far right 
of the title bar, above the sweep window. 

Esc Key
Press this key to cancel the parameter change being made and exit the current menu 
function, if applicable.

Arrow Keys
The four arrow keys are used to scroll through a list and highlight the item you wish to select, 
or to change the value of the currently selected parameter. The arrow keys can also be used to 
move markers. The rotary knob performs similar functions.

Enter Key
Press this key to apply a parameter value or instrument setting you have entered, or to select 
a highlighted item from a list.

Rotary Knob
Turn the rotary knob to change numerical values, scroll through selectable items in a list, or 
to move markers. Values or items may be within a dialog box or an edit window.

Figure 2-2. Shift Key Icon in Title Bar



2-3 Instrument Front Panel Instrument Overview 

2-4 PN: 10580-00328  Rev. L MS2711E User Guide

Menu Key
The Menu key displays a grid of shortcut icons for installed measurement modes and 
user-selected menus and setup files. See Figure 2-3. Press one of the icons in the top three 
rows to switch to the corresponding application. These icons are system-generated and cannot 
be moved or deleted.

An alternative to the Menu key is to press Shift, then the Mode (9) key to display the Mode 
Selector list box. Refer to “Mode Selector” on page 2-14.  

Figure 2-3. Menu Key Screen

Note
Shortcut icons displayed in the top rows of the Menu screen vary with the 
instrument model, firmware version, and installed options. Help for the Menu 
screen is available by pressing the icon in the lower-right corner of the display.
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User-Created Shortcuts
To create a shortcut to any submenu key or main menu key, press and hold the key until a 
grid appears, showing the open locations on the Menu screen where you can place the new 
shortcut. Press one of the cells in the displayed grid to place the shortcut. See Figure 2-4. 

To create a shortcut to a setup file (.stp), press Recall under the File menu, then press and 
hold the desired file name until a grid is displayed. Select the display location of the new 
shortcut as described above.

User-defined shortcuts remain on the Menu screen until deleted. To delete or move a shortcut 
icon, press the Menu key, then press and hold the shortcut until the Customize Button dialog 
appears. See Figure 2-5. Press the appropriate button to delete or move the shortcut icon. 

Press Esc to close the dialog without deleting or moving the shortcut. Also use Esc to exit the 
Menu screen.

Figure 2-4. Placement Grid for User-Created Shortcuts

Figure 2-5. Customize Button Dialog
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2-4 Interface Screen
Figure 2-6 illustrates the Spectrum Master interface screen in Spectrum Analyzer mode, with 
touch screen menu keys, title bar, and measurement settings and results around the graph 
area, or sweep window.  

Touch Screen Keys

Main Menu Touch Screen Keys
There are five main menu keys horizontally arranged along the bottom of the interface 
screen. These keys give access to the instrument’s test and measurement functions, which are 
documented in the applicable Measurement Guide. Refer to Appendix A, “Measurement 
Guides”.

Figure 2-6. Spectrum Analyzer Display

Note
Many of the measurement settings displayed to the left and the top of the sweep 
window are actually touch screen shortcuts that you can press to bring up the 
corresponding menu.
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Different operation or measurement modes may display different main menu keys. To switch 
to another mode, press the Menu key, or press Shift followed by the Mode (9) key. 

Submenu Touch Screen Keys
Most of the instrument setup, control, and measurement functions are performed through the 
use of the submenu keys along the right side of the display. The key labels change as 
measurement settings and instrument setup parameters change. The current submenu title 
is displayed at the top of the submenu key block, which consists of up to eight touch screen 
keys. See Figure 2-6 on page 2-6.

Symbols and Icons on the Title Bar 

The instrument title bar displays the system date and time. When GPS is on and is tracking 
satellites, its icon is followed by latitude and longitude coordinates.

Press the storage icon to open the touch screen keyboard for saving measurements, setups, 
limit lines, or screen display JPEG files. This shortcut to the “Save Menu” on page 4-10 is 
equivalent to pressing Shift and File (7), then Save. Refer to “Save Dialog Box” on page 4-3.

Press the camera icon to save a JPEG image of the current screen display.

The battery symbol indicates the charge remaining in the battery. The colored section inside 
the symbol changes size and color with the charge level. See Table 2-1 on page 2-8. The 
Battery Charge LED (adjacent to the On/Off button) flashes when the battery is charging, 
and remains on steady when the battery is fully charged. 

The Shift icon is displayed after the Shift key is pressed, and it remains displayed until 
another button is pressed.

Note The installed options determine what measurement modes are available. Refer to 
Table 1-1 on page 1-2.

Figure 2-7. Title Bar with Icons

Caution 
Use only Anritsu-approved batteries, adapters, and chargers with this instrument. 
Anritsu Company recommends removing the battery for long-term storage of the 
instrument.



2-4 Interface Screen Instrument Overview 

2-8 PN: 10580-00328  Rev. L MS2711E User Guide

Symbols and Indicators
The following symbols, icons, and indicators convey the instrument status or condition on the 
display. The colors shown here are in the standard or default display mode. 

Table 2-1. Symbols and Icons

Symbol Description

Green: Battery is 30% to 100% charged.   

Yellow: Battery is 10% to 30% charged.

Red: Battery is 0% to 10% charged.

Green with Black Plug body: Battery is fully charged and 
external power is applied.

Lightning Bolt: Battery is being charged (any color symbol).

Red Plug body: External power is applied, and no battery is 
installed, or battery has lost communications with the instrument.

Storage Icon: Tap the floppy disk icon to display the Save screen 
and menu.    

Camera Icon: Saves a JPEG image of the current screen display.     

Shift Key Icon: This icon is displayed between the battery symbol 
and the submenu keys after the Shift key has been pressed, and 
until another key is pressed.
GPS Icon: This icon is displayed right after the date and time 
when GPS is available. Refer to Chapter 6, “GPS (Option 31)” for 
details.
Power Button with Power LED and Charge LED: This is a 
physical button with LED indicators. It is located near the numeric 
keypad.

Shift
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Display Settings
The Display Settings submenu lets you adjust the screen brightness level and control the 
auto-dimming function. Refer to “Brightness Settings Menu” on page 5-8.

You can also turn off the display entirely, as described in “Display Settings Menu” 
on page 5-7. To turn the display back on, press any key (except the Power button) three times 
in rapid succession.

In addition to the default display colors shown in Figure 2-6 on page 2-6, you can select 
different color schemes to suit the ambient lighting conditions. See Figure 2-8. Some color 
settings may not be available in all measurement modes.

Black on White — used for printing and viewing in broad daylight conditions

Night Vision — optimized for nighttime viewing

High Contrast — used in challenging viewing conditions

Color on White — used for printing and viewing in broad daylight conditions

Figure 2-8. Spectrum Master Display Color Settings

Black on White Night Vision

Color on WhiteHigh Contrast
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Touch Screen Calibration
Calibration optimizes the response of touch input. It is recommended if the instrument does 
not respond as expected when you press the touch screen.

The Calibrate Touch Screen submenu key is in the “System Menu” on page 5-3. When pressed, 
a message box is displayed with instructions for calibration. See Figure 2-9. Press Enter to 
begin calibration, or press Esc to cancel. Alternatively, you can press 1 while the message box 
is displayed to use the arrow keys for navigation. Refer to “Disable Touch Screen to Use 
Arrow Navigation”. 

During calibration, press the crosshairs in sequence as they appear on the screen. The 
process takes less than one minute.

Calibrate Touch Screen Shortcut
Another way to access touch screen calibration is to press Shift, then 0 (zero). This displays 
the touch screen calibration message box shown in Figure 2-9. The shortcut can be used if 
your touch inputs do not correspond to the appropriate locations on the screen to such an 
extent that you cannot access the Calibrate Touch Screen submenu key.

Disable Touch Screen to Use Arrow Navigation
If the touch screen is not functioning, you can use Arrow Navigation to simulate pressing the 
touch screen main menu keys and submenu keys. From the touch screen calibration message 
box (see Figure 2-9), press 1 to display the arrow navigation message box, illustrated in 
Figure 2-10. Press 1 again to enter the arrow navigation mode, or press Esc to cancel. 

In arrow navigation mode, a red border highlights the currently selected key (see Figure 2-11 
on page 2-11). Use the arrow keys to move the red selection box, then press the Menu key to 
activate the highlighted key. Only the main menu keys and submenu keys can be activated 
using Arrow Navigation. This feature does not move the red selection box into other areas of 
the touch screen, like the display title bar, sweep window, or the instrument settings area on 
the left.

Figure 2-9. Touch Screen Calibration Message Box

Figure 2-10. Arrow Navigation Message Box
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To save a measurement in arrow navigation mode, press Shift then File (7). Use the arrow 
keys to move the red selection box to the Save Measurement As submenu key. This submenu 
key must be used because the arrow navigation mode cannot be used to change data in popup 
windows in the measurement display. File names are determined by the current setting of the 
Save Measurement As submenu key. Refer to “Save Measurement As” on page 4-9.

You can save a JPEG image of the current display screen by pressing Shift, followed by 
Decimal, then +/–. The JEPG image shows screen data, but does not contain the additional 
measurement information that accompanies a saved measurement in a *.spa measurement 
file.

To return to normal touch entry mode, reboot the instrument (turn power Off, then On). If 
your touch screen has been damaged, refer to “Contacting Anritsu” on page 1-1. 

Figure 2-11. Arrow Navigation Example
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2-5 Data Entry
User input can be in the form of numeric values for instrument or measurement settings, 
selected values from a preset list, or alphanumeric text when entering file names, for 
example. To view or change a parameter value, access the appropriate submenu by pressing 
one of the five main menu keys along the bottom of the interface screen, then navigating 
through the touch screen submenus.

Other instrument functions are accessible from the numeric keypad, when used in 
combination with the Shift key. Refer to “Numeric Keypad” on page 2-3. Some of the 
parameter settings displayed on the left of the interface screen or under the title bar are 
touch screen shortcuts to related submenus.

Depending on the measurement mode, refer to the associated Measurement Guide listed in 
Appendix A for a description of available menus and submenus.

Numeric Values
To modify a numeric parameter setting that is displayed on a submenu touch screen key, 
press the key to make it active. The display color of the currently set value changes to red. 
Use the rotary knob, arrow keys, or the numeric keypad to change the value. When entering a 
value from the keypad, the submenu typically shows the selectable units. Press the desired 
unit or press Enter to complete the entry.

Selection Lists
Some parameters and instrument functions are selectable from a pop-up list. These list boxes 
display the available selections, and value limits if applicable. Use the arrow keys or the 
rotary knob to scroll through the list and highlight the desired entry. You can also use the 
touch screen to make your selection.

To apply the selection, press Enter. To exit the selection list without making a change, press 
the Escape (Esc) key.
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Text Entry 
When an instrument function requires you to enter text, such as a name for a measurement 
or setup file you wish to save, a touch screen keyboard is displayed. See Figure 2-12. Digits 
can be entered using the touch screen keyboard or the front panel keypad. The left and right 
arrow keys move the insertion point in the file name edit box.

Refer to “Save Dialog Box” on page 4-3 for information on saving files.

Figure 2-12. Touch Screen Keyboard
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2-6 Mode Selector 
To change to another operation or measurement mode, press Shift, then the Mode (9) key to 
display the Mode Selector list box, illustrated in Figure 2-13. Use the directional arrow keys 
or the rotary knob to highlight the desired mode, then press Enter to switch to the selected 
application. The measurement modes available for selection depend on the options that are 
installed and activated on your instrument.

An alternate method of selecting a measurement mode is through the use of the “Menu Key” 
on page 2-4. 

Figure 2-13. Mode Selector List Box
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2-7 Connector Panel 
The Spectrum Master connector panel is illustrated in Figure 2-14.  

External Reference In  
The External Reference In port is a 50 Ω BNC female connector that provides for input of an 
external frequency reference. Refer to your Technical Data Sheet for valid frequencies. To 
prevent damage to your instrument, do not use pliers or a wrench to tighten the BNC 
connector.

External Trigger  In
A TTL signal that is applied to the External Trigger female BNC input connector causes a 
single sweep to occur. In the Spectrum Analyzer mode, it is used in zero span, and triggering 
occurs on the rising edge of the signal. After the sweep is complete, the resultant trace is 
displayed until the next trigger signal arrives.

Figure 2-14. Spectrum Master Connector Panel

1. External Reference In
2. External Trigger In
3. Analyzer/RF In (Type N)
4. USB Mini-B
5. GPS Type SMA (Option 31)
6. External Power
7. USB Type A
8. Headset jack
9. Generator/RF Out Type N (Option 20)
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Analyzer/RF In
This is a 50 Ω Type-N female connector. The maximum input is +33 dBm at ±50 VDC.

USB Interface – Mini-B
The USB 2.0 Mini-B connector can be used to connect the Spectrum Master directly to a PC. 
The first time the Spectrum Master is connected to a PC, the normal USB device detection by 
the computer operating system will take place. 

GPS Antenna Connector (Option 31)
The GPS antenna connection on the Spectrum Master is type SMA-female. GPS function is 
described in Chapter 6, “GPS (Option 31)”.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
SMA connector. Do not over-tighten the connector. The recommended torque is 8 lbf·in 
(0.9 N·m or 90 N·cm).

External Power
This is a 2.1 mm by 5.5 mm barrel connector, 12 to 15 VDC, < 4.0 A. The external power 
connector is used to power the unit and for battery charging. A green blinking LED near the 
Power button indicates that the instrument battery is being charged by the external charging 
unit. The indicator is a steady green when the battery is fully charged. 

Refer to “External Power On” on page 3-8 and “Power-On Menu” on page 5-6 when controlling 
the instrument via external power.

USB Interface – Type A
The Spectrum Master has two Type A USB connectors that accept USB Flash Memory 
devices for storing measurements, setup data, and screen images.

Headset Jack
The headset jack provides audio output from the built-in AM/FM/SSB demodulator for testing 
and troubleshooting wireless communication systems. The jack accepts a 3.5 mm 3-wire 
miniature phone plug such as those commonly used with cellular telephones.

Generator/RF Out (Option 20)
RF output, 50 Ω impedance, for tracking generator (Option 20). The maximum input is 
+23 dBm at ±50 VDC.

Note For proper detection, the applicable Anritsu Software Tool should be installed on 
the PC prior to connecting the Spectrum Master to the USB port.

Warning

When using the AC-DC Adapter, always use a three-wire power cable that is 
connected to a three-wire power line outlet. If power is supplied without grounding 
the equipment in this manner, the user is at risk of receiving a severe or fatal 
electric shock.
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2-8 Soft Carrying Case
The Spectrum Master can be operated while in the soft carrying case. On the back of the case 
is a large storage pouch for accessories and supplies.

To install the instrument into the soft carrying case:

1. The front panel of the case is secured with hook-and-loop fasteners. Fully close the 
front panel of the case. When closed, the front panel supports the shape of the case 
while you are inserting the Spectrum Master.

2. Place the soft carrying case face down on a stable surface, with the front panel fully 
closed and laying flat.

3. Open the zippered back of the case.

4. Insert the instrument face down into the case, take care that the connectors are 
properly situated in the case top opening. You may find it easier to insert the 
connectors first, then pull the corners over the bottom of the Spectrum Master.

5. Close the back panel and secure with the zipper to secure the Spectrum Master.

Note

The soft case has two zippers near the back. The zipper closer to the front of the 
case opens to install and remove the instrument. The zipper closer to the back of 
the case opens an adjustable support panel that can be used to provide support for 
improved stability and air flow while the instrument is in the case. This support 
panel also contains the storage pouch.

Figure 2-15. Instrument Inserted into the Soft Carrying Case
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The soft carrying case includes a detachable shoulder strap, which can be connected to the 
D-rings of the case.

2-9 Tilt Bail Stand
A Tilt Bail is attached to the back of the Spectrum Master for desktop operation. The tilt bail 
provides two settings of backward tilt for improved stability. To deploy the tilt bail, pull the 
bottom of the tilt bail away from the back of the instrument. To store the tilt bail, push the 
bottom of the bail towards the back of the instrument until it attaches to the Spectrum 
Master. 

Caution The soft case has panel openings for the fan inlet and exhaust ports. Do not block 
the air flow through the panels when the unit is operating.

Note Do not use the tilt bail while the instrument is in the soft case. The soft case has an 
adjustable support panel in the back zipper.

Figure 2-16. Tilt Bail Extended
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Chapter 3 — Quick Start Guide

3-1 Introduction
This chapter provides a brief overview of basic measurement setups. For detailed descriptions 
of measurement functions and settings, refer to the appropriate Measurement Guide as listed 
in Appendix A.

3-2 Measurement Mode Selection
Press the Menu key, then press the shortcut icon for the desired application, or measurement 
mode. See Figure 3-1. Alternatively, you can press Shift followed by the Mode (9) key, then 
select the measurement mode from the Mode Selector list box.

Figure 3-1.  Menu Screen - Shortcuts to Installed Applications

Note The application shortcuts displayed in the top rows of the Menu screen will vary 
depending on the firmware and options installed on the instrument.
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3-3 Spectrum Analyzer
Set the instrument to Spectrum Analyzer mode as described in Section 3-2 “Measurement 
Mode Selection” on page 3-1.

Set the Frequency
Set Start and Stop Frequencies

1. Press the Freq main menu key. 

2. Press the Start Freq submenu key.

3. Enter the desired start frequency using the keypad, the arrow keys, or the rotary knob. 
When entering a frequency using the keypad, the submenu key labels change to GHz, 
MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same 
affect as pressing the MHz submenu key.

4. Press the Stop Freq submenu key.

5. Enter the desired stop frequency.

Set the Center Frequency
1. Press the Freq main menu key.

2. Press the Center Freq submenu key.

3. Enter the desired center frequency using the keypad, the arrow keys, or the rotary 
knob. When entering a frequency using the keypad, the submenu key labels change to 
GHz, MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the 
same affect as pressing the MHz submenu key.

The center frequency and span is shown at the bottom of the screen.

Select a Signal Standard
1. Press the Freq main menu key.

2. Press the Signal Standard submenu key. The Signal Standards dialog box opens.

3. Highlight a signal standard and press Enter to select.

4. Press the Channel submenu key to change the channel value in the Channel Editor.

The signal standard is shown in yellow at the top of the screen.

Set the Frequency Offset
1. Press the Freq main menu key.

2. Press the Step Size & Other submenu key. 

3. Press the Freq Offset submenu key and enter the desired frequency offset using the 
keypad, the arrow keys, or the rotary knob. When entering a frequency using the 
keypad, the submenu key labels change to GHz, MHz, kHz, and Hz. Press the 
appropriate unit key. Pressing the Enter key has the same affect as pressing the MHz 
submenu key.

4. Offset will be displayed at the bottom of the screen. The Center Freq, Start Freq, and 
Stop Freq keys will also indicate that a frequency offset has been turned on.
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5. Set the Freq Offset to 0 Hz to remove the frequency offset.

Set the Measurement Frequency Bandwidth
1. Press the BW main menu key to display the BW menu.

• Press the RBW and/or the VBW submenu key to manually change the values.

• Set RBW and VBW automatically by pressing the Auto RBW submenu key or the 
Auto VBW submenu key.

2. Press the RBW/VBW submenu key to change the resolution bandwidth and video 
bandwidth ratio.

3. Press the Span/RBW submenu key to change the span width to resolution bandwidth 
ratio.

Set the Amplitude
Press the Amplitude main menu key to display the Amplitude menu.

Set Amplitude Reference Level and Scale
1. Press the Reference Level submenu key and use the arrow keys, rotary knob, or the 

keypad to change the reference level. Press Enter to set the reference level value.

2. Press the Scale submenu key and use the arrow keys, rotary knob, or the keypad to 
enter the desired scale. Press Enter to set the scale value.

Set Amplitude Range and Scale
1. Press the Auto Atten submenu key to set an optimal reference level based on the 

measured signal.

2. Press the Scale submenu key.

3. Enter the desired scale units by using the keypad, the arrow keys, or the rotary knob. 
Press Enter to set. The y-axis scale is automatically renumbered.

Note
The Freq Offset will affect the displayed values of frequencies, Markers and Limits.  
The currently frequency offset value is displayed on the Freq Offset submenu key, 
located under the Freq main menu > Step Size & Offset submenu. 
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Reference Level Offset for External Loss or External Gain
To obtain accurate measurements, compensate for any external attenuation or gain by using 
the RL Offset submenu. The compensation factor is in dB. External attenuation can be 
created by using an external cable or an external high power attenuator, external gain is 
typically from an amplifier.  

To adjust the reference level for either gain or loss, press the RL Offset submenu key and 
enter a positive dB value and then press the appropriate submenu key (dB External Gain or 
dB External Loss). The new RL Offset value will be displayed on the instrument and reference 
level is adjusted.

Set the Span
1. Press the Span main menu key or the Freq main menu key followed by the 

Span submenu key.

2. To select full span, press the Full Span submenu key. Selecting full span overrides any 
previously set Start and Stop frequencies.

3. For a single frequency measurement, press the Zero Span submenu key.

Single Limit Line
Press the Limit menu key to display the Limit menu.

1. Press the Limit (Upper / Lower) submenu key to select the desired limit line, 
Upper or Lower.

2. Activate the selected limit line by pressing the On Off submenu key so that On is 
underlined.

3. Press the Limit Move submenu key to display the Limit Move menu. Press the first 
Move Limit submenu key and use the arrows keys, rotary knob, or keypad to change the 
dBm level of the limit line.

4. Press the Back submenu key to return to the Limit menu.

5. If necessary, press the Set Default Limit submenu key to redraw the limit line in view.

Note
To quickly move the span value up or down, press the Span Up 1-2-5 or Span 
Down 1-2-5 submenu keys These keys facilitate a zoom-in, zoom-out feature in a 
1-2-5 sequence.
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Create a Limit Envelope
1. Press Shift then Limit (6) to open the Limit menu.

2. Select Limit Envelope.

3. Press the Create Envelope key.

Figure 3-2. Limit Envelope
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Setting Up Markers
Press the Marker main menu key to display the Marker menu.

Selecting, Activating, and Placing a Marker
1. Press the Marker 1 2 3 4 5 6 submenu key and then select the desired marker using the 

touch screen marker buttons. The selected marker is underlined on the Marker 
submenu key. 

2. Press the On Off submenu key so that On is underlined. The selected marker is 
displayed in red and ready to be moved.

3. Use the rotary knob to place the marker on the desired frequency.

4. Repeat steps 1 through 3 to activate and move additional markers.

Selecting, Activating, and Placing a Delta Marker:
1. Press the Marker 1 2 3 4 5 6 submenu key and select the desired delta marker. The 

selected marker is underlined.

2. Press the Delta On Off submenu key so that On is underlined. The selected marker is 
displayed in red and ready to be moved.

3. Use the rotary knob to place the delta marker on the desired frequency.

4. Repeat steps 1 through 3 to activate and move additional markers.

Viewing Marker Data in a Table Format
1. Press the More submenu key.

2. Press the Marker Table submenu key so that On is underlined. All marker and delta 
marker data are displayed in a table under the measurement graph.

Figure 3-3. Marker Table
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Select a Measurement Type
In Spectrum Analyzer mode, press Shift then Measure (4) and select a measurement using 
the submenu keys.

Figure 3-4. Spectrum Analyzer Measure Menu
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External Power On
The When DC Applied setting in the Power-On menu allows the instrument to restart 
automatically when external DC power is applied to the connector shown in Figure 2-14 
on page 2-15. Refer to “External Power” on page 2-16 and the “Power-On Menu” on page 5-6.

When this feature is enabled, the instrument in the off state will turn on when external DC 
power is applied. The instrument turns off when external power is removed, even if a battery 
is installed. This is useful for high-reliability remote operation, where the instrument may 
need to be rebooted using a remotely-controlled power switch.

If the instrument is turned on with the power switch, then external power is removed, the 
instrument will continue to run until the battery is depleted. It will come on and the battery 
will begin recharging when external power is applied. This state is useful when the 
instrument is in a location where the power source may be interrupted.
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Chapter 4 — File Management

4-1 Introduction
This chapter describes the file management features of the Spectrum Master and the related 
touch screen menus. The File menu and its submenus allow you to save, recall, copy, and 
delete files in internal memory or an external USB flash drive.

4-2 Managing Files
Press the Shift key, then the File (7) key on the numeric keypad to display the File menu.

File Types
Under the Save, Recall, Copy, and Delete menus, press the Change Type or the File Type 
submenu key to open the Select File Type list box, where you can select the desired file type.

Available file types depend on the measurement mode and instrument model. The Select File 
Type list box may contain the following entries:

• ALL (displays all file types)

• Setup, *.stp 
(Setup files contain basic instrument information, measurement mode setup details, 
measurement marker data, and limit data.)

• Measurement, *.spa, *.ia, *.cs, *.edg, *.wcd, *.tds, *.lte, *.tdlte, 
*.cdma, *.evdo, *.wmxd, *.wmxe, *.afp 
(Measurement files contain all of the information in the setup files and the 
measurement data. File extensions are determined by the current measurement mode 
and selected file type.)

• JPEG, *.jpg 
(Image file is a screen capture of the current measurement display.)

• Limit Lines, *.lim 
(The Limit Line file contains limit line data details.)

• Spurious Emission Mask, *.spe 
(The Spurious Emission Mask file contains the frequency, amplitude, and other 
information related to segments in an out-of-band spurious emission mask.)

• KML 2D, *.kml 

• KML 3D, *.kml 

• Mapping Tab Delimited, *.mtd 

You can also use the touch screen to open the drop down list for the Filetype entry box, as 
shown in Figure 4-1 on page 4-2.

Note
When navigating through the File menu, press the Esc key to return to the 
previous menu or submenu. Any changes not yet applied (by pressing Enter) are 
canceled.
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Save Files
The submenu keys that are available for file management may vary with instrument options 
and measurement modes. Refer to “File Menu” on page 4-9.

Save Measurement As
The Save Measurement As submenu key provides a one-touch method of saving the current 
measurement data. The name of the file that will be saved is displayed on the submenu key. 
The numerical suffix increments by 1 following the Save. For example, if the last 
measurement was saved with the file name ACPR, the Save Measurement As shows the 
default file name for the next measurement to be saved as ACPR_1, then ACPR_2, and so on. 
To save using a different file name than the default, press the Save Measurement key or the 
Save key instead of Save Measurement As.

Save Measurement
To save the current measurement data, use the Save Measurement As submenu key described 
above or, to apply a different file name or save location than the default, press the Save 
Measurement submenu key or the Save key. In the Save dialog, you can enter the file name 
and select the type of data to save. See Figure 4-1 and refer to “Save Dialog Box” on page 4-3.

Save
The Save submenu key has the same function as Save Measurement. It opens the Save dialog 
box and menu illustrated in Figure 4-1. 

Figure 4-1. Save Dialog Box
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Save Dialog Box
In the Save dialog, use the touch screen keyboard to enter the name of the file to save. See 
Figure 4-1 on page 4-2. Optionally, you can use the Quick Name keys to insert preset text 
strings into the file name. Refer to “Quick Name Keys”.

To select the type of data to save, either press the Filetype selection box to display the drop 
down list of available file types, or press the Change Type submenu key. Selectable file types 
vary with the measurement mode. Use the Up/Down arrow keys to highlight the desired file 
type, then press Enter to select.

Press Enter again to save the file. File name extensions are automatically assigned based on 
the file type and measurement mode. Refer to “File Types” on page 4-1.

Quick Name Keys
Quick Name keys in the Save dialog provide optional building blocks for entering file names. 
They function as keyboard shortcuts, allowing you to enter predefined, frequently used file 
names or parts of file names. To enter or change a Quick Name, press the Change Quick Name 
submenu key in the Save menu, then select the item to edit (see Figure 4-2) and press Enter 
on the numeric keypad. In the Edit Quick Name dialog, use the touch screen keyboard to 
enter a new Quick Name. See Figure 4-3. Press Enter again and the new name will be 
displayed on the key, in the Save dialog.  

Figure 4-2. Select Quick Name List Box

Figure 4-3. Edit Quick Name Dialog Box
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Change Save Location
You can save files to internal memory or to an external USB flash drive. To change the 
destination location of the saved file, press the Change Save Location submenu key under the 
Save menu. Figure 4-4 illustrates the directory structure of the instrument’s internal memory 
and external USB drive or drives, if connected. Only folders are listed, not files. 

Use the touch screen, the Up/Down arrow keys, or the rotary knob to select a folder from the 
list. To expand a folder and view its subfolders, press Enter or the Right arrow key. Press 
Enter again or the Left arrow key to collapse the folder. To create a new folder, press the 
Create Folder submenu key.

After selecting the folder, press the Set Location key to store the save location. Refer to 
“Save Location Menu” on page 4-11 for a description of the submenu keys.

Save On Event
This menu is not available in all modes of operation. The menu is used to automatically save 
measurement data to the current save location after a selected event type. Refer to 
“Save On... Menu” on page 4-12.

Figure 4-4. Save Location Screen
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Recall Files
Press the Recall Measurement key or the Recall key under the File menu to recall a previously 
saved file from internal memory or an external USB drive, if connected. The files listed in the 
Recall dialog box depend on the file type selected. See Figure 4-5. JPEG image files cannot be 
recalled. 

The submenu keys let you change the file types and sort order of the displayed file list. Refer 
to “Recall Menu” on page 4-13.

The Filetype drop down list has the same function as the File Type submenu key. Selectable 
file types vary with the measurement mode. Use the touch screen, rotary knob, or the 
Up/Down arrow keys to select the file you wish to recall, then press Enter.
From the Recall dialog box, you can create a shortcut to a setup file and place the shortcut 
icon on the instrument’s Menu screen. Refer to “User-Created Shortcuts” on page 2-5.

Figure 4-5. Recall Dialog Box
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Copy Files
Press the Copy key under the File menu to open the Copy dialog box and menu, where you 
can copy a single or multiple files or folders. The source and destination locations may be the 
instrument’s internal memory or an external USB drive, if connected. The source files listed 
in the Copy dialog box depend on the chosen file type, which is selected using either the 
Filetype drop down list or the File Type submenu key. You can also change the way folders 
and files are sorted in the displayed list. Refer to “Copy Menu” on page 4-14.

The Filetype drop down list has the same function as the File Type submenu key. Selectable 
file types vary with the measurement mode. Files and folders to copy are listed in the top 
pane of the Copy dialog box. Select the destination in the bottom pane. See Figure 4-6. 

1. To copy to or from an external USB drive, insert the flash drive into a USB port on the 
instrument. Otherwise, skip to the next step.

2. Press the Shift key, followed by File (7), then press the Copy submenu key.

3. Use the submenu keys to select the type of file to copy and the display order of folders 
and files, as appropriate.

4. Make sure the Scroll submenu key is toggled to Src (source).

5. Use the touch screen, rotary knob, or the Up/Down arrow keys to locate and highlight 
(that is, frame) the file or folder you wish to copy. To open a highlighted folder, press 
Enter. Press Enter again or press the Left arrow key to close it.

6. To select a highlighted file or folder for copying, press the Select or De-Select submenu 
key. The selected item is highlighted in blue.

7. If needed, repeat Step 5 and Step 6 to select more files or folders to copy.

Figure 4-6. Copy Dialog Box
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8. Press the Scroll key to switch navigation control to the Dst (destination) pane. 
Alternatively, you can directly press a folder in the bottom pane to select it.

9. If the destination folder is off the screen, use the rotary knob or the Up/Down arrow 
keys to locate and select it.

10. Press the Copy key to copy the selected files or folders.

If a file by the same name already exists in the destination location, an error message is 
displayed, prompting you to press Enter to overwrite, or Esc to skip the conflicting file.

Delete Files 
Press the Delete key under the File menu to open the Delete dialog box and menu, where you 
can delete a single or multiple files or folders. Items to be deleted may be in the instrument’s 
internal memory or an external USB drive, if connected. However, you cannot select files and 
folders located in different drives simultaneously.

The files listed in the Delete dialog box depend on the chosen file type, which is selected using 
either the Filetype drop down list or the File Type submenu key. You can also change the way 
folders and files are sorted in the displayed list. Refer to “Delete Menu” on page 4-15. 

Use the touch screen, rotary knob, or the Up/Down arrow keys to highlight the file or folder 
you wish to delete. Then, press the Select or De-Select submenu key. The selected item is 
highlighted in blue. Pressing the key again deselects the current item.

To delete multiple files or folders, scroll to the next item and press the Select or De-Select key. 
Press the Delete key, then confirm or cancel the deletion in the confirmation box.

Figure 4-7. Delete Dialog Box
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4-3 File Menu Overview
Open this menu by pressing the Shift key, then the File (7) key. 

Figure 4-8. File Menu
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4-4 File Menu 
Key Sequence: Shift > File (7)

Save Measurement As: Pressing this key will save instrument setup 
parameters, trace data, and any measurement results to the file that is 
named on the submenu key. Upon Save completion, the file name numerical 
suffix increments by 1 and will be applied to the next Save. The file extension 
is determined by the current measurement mode, such as .spa for Spectrum 
Analyzer mode.

To save to a different file name than the default shown, or to change the save 
location, use the Save Measurement or the Save submenu key.
Save Measurement: Press this submenu key to display the “Save Menu” 
and Save dialog box. You can optionally enter a different file name using the 
keyboard in the Save dialog. You may also select the file type from the drop 
down list, as illustrated in Figure 4-11 on page 4-10. The list of available file 
types varies with the measurement mode.
Press Enter to save to the named file and return to the File menu. Pressing 
Esc exits the Save menu and dialog without saving.

The destination file for the saved data may be in the instrument’s internal 
memory or an external drive, typically a USB drive. To change the save 
location, refer to the “Save Location Menu” on page 4-11.
Save: Press this submenu key to display the “Save Menu” and Save dialog 
box. The available settings are the same as those of the Save Measurement 
key.
Save on Event (Not available in all measurement modes): Press this 
submenu key to display the “Save On... Menu” on page 4-12.

Recall Measurement: Press this submenu key to display the “Recall Menu” 
on page 4-13. Use this menu to recall measurement files from internal 
memory or an external drive, such as a USB memory stick.
Recall: Press this submenu key to display the “Recall Menu” on page 4-13. 
The available settings are the same as those of the Recall Measurement key. 
Use this menu to recall files (such as measurements, setups, limit lines, 
maps) from internal memory or an external drive.

Copy: Press this submenu key to display the “Copy Menu” on page 4-14. 
Use this menu to copy files and folders. The source and destination locations 
may be the instrument’s internal memory or an external USB drive.
Delete: Press this submenu key to display the “Delete Menu” on page 4-15 
and a selection box that lists the contents of internal memory and an external 
drive if connected. Use the rotary knob or the Up/Down arrow keys to scroll 
to the file that is to be deleted and press the Select or De-Select submenu 
key, then Delete. Press the Esc key to cancel the operation. Note that 
deleted files cannot be recovered.

Figure 4-9. File Menu
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Save Menu 
Key Sequence: Shift > File (7) > Save Measurement
Key Sequence: Shift > File (7) > Save  

Restore Default Quick Name Buttons: Press this submenu key to undo 
any Quick Names previously entered and return all Quick Name buttons to 
factory defaults.
Change Quick Name: Press this key to change the Quick Names at the 
bottom of the touch screen keyboard (see Figure 4-11). Select the Quick 
Name to edit, then press Enter. Type the new Quick Name and press Enter 
again. The new Quick Name is displayed on the button below the keyboard.
Change Save Location: Press this submenu key to open the 
“Save Location Menu”, where you can set the location of the destination file 
for saved data.

Change Type
Setup/JPEG/... Press this submenu key to open the Select File Type list 
box and the “File Type Menu”.

Figure 4-10. Save Menu

Figure 4-11. Save Dialog Box
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File Type Menu
Key Sequence: Shift > File (7) > Save Measurement > Change Type 

Key Sequence: Shift > File (7) > Save > Change Type 

Save Location Menu 
Key Sequence: Shift > File (7) > Save > Change Save Location 

JPEG Capture
Full Graph Only: Press this submenu key to toggle between file types, Full 
and Graph Only. Choose Full to include all of the additional data on the 
measurement screen. Choose Graph Only to capture just the measurement 
trace in the sweep window.

Figure 4-12. File Type Menu
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Figure 4-13. Save Location Menu
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Save On... Menu 
Key Sequence: Shift > File (7) > Save On Event 

In Spectrum Analyzer mode, this menu is used to automatically save 
measurements to the current save location after any of the following events:
...Crossing Limit
On Off: When this submenu key is set to On, measurement data is 
automatically saved when the trace crosses a limit line that has been 
specified with the Limit menu.
...Sweep Complete
On Off: When this key is set to On, measurement data is automatically 
saved after the current sweep is completed.

Save Then Stop
On Off: Set this key to On to stop the sweep after a measurement is 
saved. If this setting is Off and Sweep Complete is On, a measurement is 
saved after every sweep.
Clear All: Press this key to turn Off all three Save On Event keys:

Crossing Limit

Sweep Complete
Save Then Stop

Back: Press this key to return to the “File Menu” on page 4-9.

Figure 4-14. Save On Menu
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Recall Menu 
Key Sequence: Shift > File (7) > Recall 

Use these menu keys to change the way files are listed in the Recall dialog 
box. Navigate to the desired file, then press Enter to recall.
When recalling a saved setup, all current instrument settings are replaced by 
the stored setup information. When recalling a saved measurement and 
multiple traces are displayed, parameter settings shown on the instrument 
screen may reflect those of the recalled trace or the active trace, depending 
on the measurement mode or other factors.
Sort By
Name Type Date: Press this submenu key to choose the item by which 
folders and files are sorted in the Recall dialog box. See Figure 4-5 
on page 4-5.

Sort Order
Ascend Descend: Press this key to toggle the sort order of the file list 
between Ascending and Descending.
File Type: Press this submenu key to open the Select File Type list box. 
Press the desired file type on the list, then press Enter to apply the selection. 
JPEG image files cannot be recalled and are not listed.
Alternatively, you can select directly from the Filetype drop down list in the 
Recall dialog box.

Refresh Directories: Press this key to update the file list after connecting 
or disconnecting an external USB drive.

Figure 4-15. Recall Menu
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Copy Menu 
Key Sequence: Shift > File (7) > Copy 

Sort By
Name Type Date: Press this submenu key to choose the item by which 
folders and files are sorted in the Copy dialog box. See Figure 4-6 
on page 4-6.

Sort Order
Ascend Descend: Press this key to toggle the sort order of the file list 
between Ascending and Descending.
File Type: Press this submenu key to open the Select File Type list box. 
Press the desired file type on the list, then press Enter to apply the 
selection.

Alternatively, you can select directly from the Filetype drop down list in the 
Copy dialog box.
Refresh Directories: Press this key to update the file list after connecting 
or disconnecting an external USB drive.
Scroll
Src Dst: Press this submenu key to shift navigation control between the 
source and destination panes in the Copy dialog box.

Select or De-Select: Press this key to select or deselect the current file or 
folder. Selected items are highlighted in blue.
Copy: Copies the selected files and folders, highlighted in blue in the top 
pane of the Copy dialog box, to the selected location in the bottom pane. If a 
file by the same name already exists in the destination location, an Error 
message is displayed, prompting you to press Enter to overwrite, or Esc to 
skip the conflicting file.

Figure 4-16. Copy Menu
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Delete Menu
Key Sequence: Shift > File (7) > Delete 

Sort By
Name Type Date: Press this submenu key to choose the item by which 
folders and files are sorted in the Delete dialog box. See Figure 4-7 
on page 4-7.
Sort Order
Ascend Descend: Press this key to toggle the sort order of the file list 
between Ascending and Descending.
File Type: Press this submenu key to open the Select File Type list box. 
Press the desired file type on the list, then press Enter to apply the 
selection.

Alternatively, you can select directly from the Filetype drop down list in the 
Delete dialog box.
Select or De-Select: Press this key to select or deselect the current file or 
folder. Selected items are highlighted in blue.
Delete: Deletes the selected files or folders, which are highlighted in blue. 
In the confirmation box, press Yes to delete, No to cancel. You can also 
press Esc to cancel the deletion.

Refresh Directories: Press this key to update the file list after connecting 
or disconnecting an external USB drive.

Figure 4-17. Delete Menu
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Chapter 5 — System Operations 

5-1 Introduction
This chapter reviews the Spectrum Master system operations and related menus. The other 
menus (Sweep, Measure, Trace, and Limit) are described in the Measurement Guides listed 
in Appendix A.
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5-2 System Menu Overview 
To access the System menu functions, press the Shift key, then the System (8) key. 

Figure 5-1. System Menu
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5-3 System Menu 
Key Sequence: Shift, System (8) 

Status: Pressing this submenu key displays the current system status, 
including the operating system and firmware versions, temperatures and 
other details such as current battery information. Press Esc or Enter to 
return to normal operation.

Self Test: This key initiates a series of diagnostic tests related to the 
performance of the motherboard hardware. A display will list the individual 
tests with a pass or fail indication. Press Esc or Enter to return to normal 
operation.
If the self test fails when the battery is fully charged and the instrument is 
within the specified operating temperature, contact your Anritsu Service 
Center and report the test results.
Application Self Test: This key initiates a series of diagnostic tests related 
to the performance of the instrument for specific applications. A display will 
list the individual tests with a pass or fail indication. Press Esc or Enter to 
return to normal operation.

GPS: Opens the “GPS Menu” on page 6-4.
Calibrate Touch Screen: If the instrument does not respond as expected 
when you press the touch screen, press this key to display the touch screen 
calibration message box. Refer to “Touch Screen Calibration” on page 2-10.
The front panel shortcut equivalent of this submenu key is Shift, 0 (zero). 
Refer to “Calibrate Touch Screen Shortcut” on page 2-10.

Application Options: This submenu changes with the measurement mode. 
Refer to the appropriate Measurement Guide, as listed in Appendix A.
System Options: This key opens the “System Options Menu” on page 5-4.

Figure 5-2. System Menu
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System Options Menu  
Key Sequence: Shift, System (8) > System Options 

Date and Time: Press this submenu key to display a dialog box for setting 
the current date and time. Use the submenu keys or the Left/Right arrow 
keys to select the field to be modified. Use the keypad, the Up/Down arrow 
keys, or the rotary knob to select the date and time. Press Enter to accept 
the changes, or press the Esc key to return to normal operation without 
making changes.
Language: Press this submenu key to open a list box and select a built-in 
language for the instrument display. Press Enter to apply the change, or 
press Esc to cancel.

The languages that are currently available are: English, French, German, 
Spanish, Japanese, Chinese, Korean, Italian, Russian, and Portuguese. You 
can edit non-English language captions using Master Software Tools (MST). 
If a mode does not have language translations available, then English is the 
default language.

Caution: A firmware update or any instrument reset will overwrite 
modifications you may have made in any of the language files.

Display: The Display submenu key opens the “Display Settings Menu” 
on page 5-7, allowing brightness control and the selection of different display 
attributes.
Name: Press this submenu key to open the Unit Name dialog, where you 
can enter a name for the instrument, using the touch screen keyboard. Press 
Enter to save the name.
The assigned instrument name appears in measurement files, setup files, 
limit line files, and MST reports. It is displayed on the browser page banner 
when the instrument is connected to a remote PC or mobile device.

Volume: Press this submenu key to view or adjust the speaker volume. The 
current volume setting is displayed in the Volume input box. Use the numeric 
keypad, the Up/Down arrow keys, or the rotary knob to change the value, 
and press Enter to apply the change.
Reset: Press this submenu key to open the “Reset Menu” on page 5-9.
More: Press this submenu key to open the “System Options 2/2 Menu” 
on page 5-5.

Figure 5-3. System Options Menu
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System Options 2/2 Menu  
Key Sequence: Shift, System (8) > System Options > More    

Share CF & Pwr Offset
All Modes Not Shared: Press this submenu key to toggle the setting 
between All Modes and Not Shared. Select All Modes to have the current 
center frequency setting and power offset setting carried over when changing 
measurement modes. This function is not applicable to measurements that do 
not have a center frequency or power offset setting or to measurements in 
which the current center frequency or power offset setting is outside the range 
of the new measurement.

Set Remote Access Password: Press this submenu key to open the 
Password entry dialog (see Figure 5-5 on page 5-6). Use the touch screen 
keyboard to enter the new password. Passwords may contain digits, 
uppercase and lowercase letters, and the symbols - _ + . (hyphen, 
underscore, plus, period). Press Enter to save or Esc to cancel.
Setting the remote password and rebooting the instrument will lock it from 
Telnet and FTP connections. This means that connecting to the instrument via 
Master Software Tools (v2.21.1 or later), Wireless Remote Tools (WRT), or 
the Web Remote Control browser interface will require the set password. To 
unlock the instrument, remove the password by setting it to blank. The 
password is also removed following a Master Reset, Factory Defaults reset, or 
a firmware update.

Power–On: Press this submenu key to open the “Power-On Menu” 
on page 5-6.
Back: Press this submenu key to return to the “System Options Menu” 
on page 5-4.

Figure 5-4. System Options 2/2 Menu
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Power-On Menu
Key Sequence: Shift, System (8) > System Options > More > Power–On 

Figure 5-5. Remote Access Password Dialog

Power Switch: Press this submenu key to set the instrument for normal use 
of the On/Off button on the instrument front panel.
When DC Applied: Press this submenu key to set the instrument to 
automatically restart when DC power is applied to the External Power 
connector (see Figure 2-14 on page 2-15). Refer to “External Power On” 
on page 3-8.

Back: Press this submenu key to return to the “System Options 2/2 Menu” 
on page 5-5.

Figure 5-6. Power–On Menu 
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Display Settings Menu
Key Sequence: Shift, System (8) > System Options > Display  

Brightness: Opens the “Brightness Settings Menu” on page 5-8.

Display Blank: Opens the message box illustrated in Figure 5-8. Press 
Enter to turn off the display, or press Esc to abort. To turn the display back 
on, press any key (except the Power button) three times in rapid succession. 
A power cycle also turns the display back on.
Default Colors: Sets the display colors to the factory defaults. Used for 
normal viewing.
Black on White: Sets the display colors to black on a white background. 
Used for printing and viewing in broad daylight conditions. See Figure 2-8 
on page 2-9 for illustrations of the display color schemes selectable in this 
submenu.

Night Vision: Sets the display to a red-tinted color on a black background. 
The front panel keypad is backlighted in red. This setting is optimized for 
nighttime viewing.
High Contrast: Increases the black and white contrast of the default 
display. This setting is used in challenging viewing conditions.
Color on White: Sets the display background to white, the grid to gray, and 
leaves sweep data in color. This setting is used for printing and viewing in 
broad daylight conditions.

Back: Press this submenu key to return to the “System Options Menu” 
on page 5-4.

Figure 5-7. Display Settings Menu

Figure 5-8. Display Blank Message Box
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Brightness Settings Menu 
Key Sequence: Shift, System (8) > System Options > Display > Brightness  

The brightness of the display can be adjusted to optimize viewing under a 
wide variety of lighting conditions.
Brightness: Press this submenu key to open the Brightness Editor window, 
where you can adjust the display brightness level from 0 to 100, with 100 
being the brightest. See Figure 5-10. Use the rotary knob to adjust the value 
in increments of 5, or press the Up/Down arrow keys to change the value in 
increments of 25. Press the Left or the Right arrow key to jump to 0 or 100, 
respectively. Press Enter to accept the change. All display elements on the 
instrument screen are affected by the Brightness setting.
Auto Dim On/Off: Press this submenu key to toggle the display 
auto-dimming feature on and off. Enabling auto-dim can extend battery life.

Auto Dim Delay: Press this key to adjust the amount of idle time, from 1 to 
15 minutes, before the instrument display goes dim. Use the arrow keys or the 
rotary knob to adjust the value in increments of 1. You can also use the 
numeric keypad, then press Enter. Out-of-range values are ignored.
Auto Dim Brightness: Press this submenu key to select the brightness 
percentage level of the display when it is dimmed. Use the arrow keys or the 
rotary knob to adjust the value in increments of 5%, from 0% to 25%. You can 
also use the numeric keypad, then press % or the Enter key. Out-of-range 
values are ignored.
Back: Press this submenu key to return to the “Display Settings Menu” 
on page 5-7.

Figure 5-9. Brightness Settings Menu

Figure 5-10. Brightness Editor Input Box
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Reset Menu 
Key Sequence: Shift, System (8) > System Options > Reset 

Factory Defaults: Press this key to restore the instrument to the default 
settings for all measurement modes and system settings, including 
connectivity, language, and the display and audio settings. The instrument 
will power cycle when the operation is complete. Press the Enter key to 
initiate the reset, or press Esc to abort.

Note: This same reset sequence can be initiated when turning on the 
instrument by pressing Power while holding down the Esc key until 
the Anritsu splash screen is displayed.

Master Reset: Press this submenu key to restore the instrument to factory 
defaults as described above and to delete all user files from the instrument 
internal memory. The instrument will power cycle when the operation is 
complete. Press Enter to initiate the reset, or press Esc to abort.

Note: This same reset sequence can be initiated when turning on the 
instrument by pressing Power while holding down the System (8) key 
until the Anritsu splash screen is displayed.

Update Firmware: Press this submenu key to update the instrument 
operating system using an external USB drive. Press Load Firmware to start 
the update procedure, or press the Menu key to cancel and display the Menu 
key screen of application icons. Refer to “Firmware Update” on page 5-11 for 
detailed instructions.
Back: Press this submenu key to return to the “System Options Menu” 
on page 5-4.

Figure 5-11. Reset Menu
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5-4 Preset Menu
Key Sequence: Shift, Preset (1) 

5-5 Self Test 
At power on, the Spectrum Master runs through a series of quick checks to ensure that the 
system is functioning properly. The System self test runs a series of tests that are related to 
the instrument hardware. The Application self test runs a series of tests related to the 
instrument hardware that is used in the current operating mode.

If the Spectrum Master is within the specified operating range with a charged battery and the 
self test fails, contact your Anritsu Service Center at anritsu.com/contact-us.

To initiate a self test when the system is already powered up:

1. Press the Shift key, followed by the System (8) key.

2. Press the Self Test submenu key. The Self Test results are displayed.

3. Press Esc to close the Self Test results dialog.

Preset: This key resets all parameter settings for the current measurement 
mode to their factory default values, and switches the display to the default 
view for that mode. Measurement settings specific to other modes, or 
applications, are not affected.

Save Setup: Opens the Save dialog box (see Figure 4-1 on page 4-2) to 
name and save the current operating settings, allowing them to be recalled 
later to return the instrument to the state it was in at the time the setup was 
saved.
The saved setup can be named using the touch screen keyboard. Use the 
Caps key to select an uppercase letter. Use the Left/Right directional 
arrows to move the cursor position. Press Enter to save the setup.
Note: Set the File type as Setup. Refer to “Save Menu” on page 4-10 for 
details.

Recall Setup: This key allows the selection and recall of a previously 
stored instrument setup using the “Recall Menu” on page 4-13. Use the 
rotary knob, the Up/Down arrow keys, or the touch screen to highlight the 
saved setup, and press Enter. All current instrument settings are replaced 
by the stored setup information.

Figure 5-12. Preset Menu
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5-6 Firmware Update
To update your Anritsu instrument firmware, use a high quality USB memory device with at 
least 250 MB of free space and FAT32 file system format.

1. Insert the memory device into your PC or laptop.

2. From a browser, go to the following Anritsu Products page:

http://www.anritsu.com/en-US/test-measurement/mobile-wireless-communications/spe
ctrum-analyzers

3. If the Web page lists more than one product, find your instrument model number and 
click the link.

4. On the product page, press the Downloads button.

5. Under the Drivers/Firmware/Software tab, you can optionally follow the Firmware 
Revision/Release History link to download a document detailing current and past 
firmware changes.

6. Click on the link Firmware Update for the Spectrum Master MS2711E.

7. Click the Download button, then choose Save or Save As. Do not run the executable file 
directly from the Web page.

8. Go to the Save location designated in Step 7 and double-click the installer file, 
Model_Ver_USBLoader.exe.

9. In the Firmware Update dialog, click to view, then accept the software license 
agreement.

10. Click Browse and select the Removable Disk drive where the USB device is inserted.

11. Click Prepare USB Memory Stick to create the firmware update USB device.

12. After the firmware update tool has finished, click through the final steps in the 
Firmware Update dialog to close the installer program.

13. Eject the memory device from the computer. 

14. Turn off the Spectrum Master and insert the USB memory device into the instrument.

15. Make sure the Spectrum Master is plugged into an AC power source and not running 
on battery alone, then turn on the instrument.

16.  At bootup, the instrument should detect new firmware on the USB device and ask if 
you wish to upgrade. Press Yes.

17. The Automatic Firmware Update dialog should open at this time. Skip to Step 19. 

Note The file structure created on the USB memory device by the installer program is 
necessary for a successful firmware update and must not be altered in any way.

Note

If the same firmware code as contained on the USB device is already loaded on 
the instrument, a message indicating that firmware update is skipped will display 
briefly on the instrument screen.

If the firmware update on the memory device does not match your instrument 
model, an error message will display briefly, indicating that it is not compatible.

http://www.anritsu.com/en-US/test-measurement/mobile-wireless-communications/spectrum-analyzers
http://www.anritsu.com/en-US/test-measurement/mobile-wireless-communications/spectrum-analyzers
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18. If there is no error but the instrument does not enter upgrade mode automatically:

a. Press Shift > System (8) > System Options > Reset > Update Firmware.

b. Press Load Firmware at the bottom left of the instrument screen.

c. Press Update Application Firmware.

d. The Firmware Update dialog opens.

19. Use the Up/Down arrow keys or the rotary knob to select one of the Save modes.

• Save none: No attempt is made to save any user data.

• Save user data: User data is saved to the selected external media device.

• Save & restore user data: User data is saved to the selected external media 
device. The instrument also attempts to restore the files to the instrument after 
the update. 

20. Press Enter.
21. Press Enter again to confirm your intention to proceed with the firmware upgrade.

To cancel the operation, press Esc. In this case, you need to press Shift > Mode (9) and 
select an application from the Mode Selector list in order to exit upgrade mode and 
resume normal instrument operation. 

22. After the update is complete, the instrument should reboot automatically. 

Warning Some user data may be lost if not enough memory space is available on the 
selected device.

Warning
You cannot stop the upgrade once it has started. To avoid potential permanent 
damage, do not turn off the instrument or remove the USB memory device during 
the firmware update.

Note

If the instrument turns off and does not restart on its own, remove the USB memory 
device and turn on the instrument by holding down the System (8) key, then 
pressing the Power button. Keep pressing System (8) until the Anritsu splash 
screen is displayed.
Be sure to use this key combination in order to perform a Master Reset while 
turning on the instrument. Pressing the Power button alone may put the instrument 
in an unrecoverable error state.
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Chapter 6 — GPS (Option 31)

6-1 Introduction
The Spectrum Master is available with a built-in GPS receiver feature (Option 31) that can 
provide latitude, longitude, altitude, and UTC timing information. This option also enhances 
frequency reference oscillator accuracy in the spectrum analyzer mode. When GPS is actively 
locked to satellites, this information is saved with all saved measurements and can be 
displayed with Master Software Tools. No accuracy specifications apply if no GPS satellites 
are acquired.

6-2 Activating the GPS Feature
Attach the GPS antenna to the GPS Antenna connector on the top of the instrument.

1. Press the Shift key, then the System (8) key on the numeric keypad to display the 
System menu.

2. Press the GPS submenu key.

3. Activate GPS by pressing the GPS On/Off submenu key so that On is underlined. When 
GPS is first turned On, the GPS icon is displayed in red to indicate that fewer than four 
satellites are currently being tracked.

Note

The Spectrum Master Technical Data Sheet provides a list of the options and 
measurements that require GPS. In addition to having Option 31 installed, a GPS 
antenna is required. Refer to the instrument Technical Data Sheet for compatible 
GPS antennas.

Figure 6-1. GPS Icon, Red

GPS
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4. When the GPS receiver is tracking at least four satellites, the GPS icon changes to 
green. Latitude and longitude information is displayed in the title bar at the top of the 
display. Acquiring satellites may take as long as three minutes. 

5. Press the GPS Info submenu key to display the following information: 

• Tracked satellites

• Latitude and longitude

• Altitude

• UTC timing information

• Fix available

• Almanac complete

• Antenna and receiver status

• GPS antenna voltage and current

Refer to “GPS Menu” on page 6-4 for details on the above GPS Info items.

After GPS location fix is attained, the internal reference oscillator begins to correct its 
frequency to match the GPS standard. After the internal frequency is adjusted to match the 
GPS standard, the status is indicated by “GPS High Accuracy” showing in the Status menu, 
which is displayed on the left side of the measurement display. When the GPS feature is not 
enabled, the reference source displays either “Internal Standard Accuracy” or a user-selected 
external reference frequency in the Status menu.

Within three minutes of satellite acquisition, the reference oscillator will have an accuracy of 
better than 25 ppb (parts per billion). The OCXO internal standard accuracy is ±0.3 PPM. 
The correction factor applied to the internal OCXO allows the instrument to maintain GPS 
frequency accuracy for three days at better than 50 ppb, even when the instrument is 
obstructed from receiving signals from the GPS satellites.

In order to acquire data from the GPS satellites, you must have line-of-sight to the satellites, 
or the antenna must be placed outside with no obstructions.

If no GPS is connected for at least three days, the Frequency Reference annotation reads Int 
Std Accy.

When GPS is connected, with a fix, and the tuning process has completed (which may take a 
few minutes), the Frequency Reference annotation shows GPS Hi Accy. If GPS is 
subsequently lost (for example, GPS is turned off, disconnected, or there is no signal due to 
physical obstruction), the instrument goes back to Int Hi Accy after a few moments. If GPS 
remains disconnected for three consecutive days, whether the instrument is on or off, the 
instrument reverts to Int Std Accy.

Figure 6-2. GPS Icon, Green

GPS
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6-3 Resetting GPS
To reset the GPS, press the Reset submenu key. The green GPS icon shows a red cross mark 
when satellite tracking is lost after tracking four or more satellites. The GPS latitude and 
longitude are saved in the instrument memory until the Spectrum Master is turned off or 
until GPS is turned off by using the GPS On/Off key. 

6-4 Saving and Recalling Traces with GPS Information

Saving Traces with GPS Information
The GPS coordinates of a location can be saved along with a measurement trace. Refer to 
“Save Menu” on page 4-10 for more information. The current GPS coordinates will be saved 
with the measurement traces whenever GPS is on and actively tracking satellites.

Recalling GPS Information
If the GPS coordinates were saved with a measurement, the coordinates will be recalled when 
the measurement is recalled. Refer to “Recall Menu” on page 4-13 for more information on 
recalling a saved trace.

Figure 6-3. GPS Icon, Tracking Lost

GPS
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6-5 GPS Menu 
Key Sequence: Shift, System (8) > GPS 

GPS: Press this submenu key to turn GPS on or off.

GPS Info: Press this submenu key to display the current GPS information.
Tracked Satellites: Shows the number of tracked satellites (three are 
required to retrieve latitude and longitude, four are required to resolve 
altitude). Generally, the larger the number of satellites tracked, the 
more accurate the GPS information.
Latitude and Longitude: Shows location in degrees, minutes, and 
seconds.

Altitude: Shows altitude information in meters.
UTC: Universal Coordinated Time.
Fix Available: The cold start search sets are established to ensure 
that at least three satellites are acquired within the first couple of 
minutes. When three satellites are found, the receiver will compute an 
initial fix (typically in less than two minutes). Fix Available: No means 
that the initial position has not been established.

Almanac Complete: The system almanac contains information about 
the satellites in the constellation, ionospheric data, and special system 
messages. In a cold start, the GPS receiver has no navigation data, so 
the receiver does not have a current almanac. A complete system 
almanac is not required to achieve a first position fix. However, UTC 
time is not correct until the almanac is complete, and the availability of 
the almanac can significantly reduce the time to first fix.
Antenna Status:
OK: Active antenna is connected and is working properly.

Short/Open: If an active antenna is in use, a short or open exists 
between the antenna and the connection. If this message is displayed, 
replace the antenna. If the message persists, try another Anritsu GPS 
antenna. If needed, contact your nearest Anritsu Service Center. If a 
passive antenna is in use, the message should display: Antenna 
OPEN Detected or Passive Antenna Used.
Receiver Status: Current status of the receiver.
GPS Antenna Voltage and Current: Shows voltage and current.

GPS Voltage: Press this submenu key to set the source voltage at 3.3 V or 
5 V, depending on the GPS receiver being used. The default setting is 3.3 V 
to prevent accidental damage to lower-voltage GPS antennas.
Reset: The Reset key sets the number of tracked satellites to 0 and erases 
any almanac data and saved coordinates. The process of searching for and 
reacquiring satellites will begin again.
Back: Press this submenu key to return to the “System Menu” on page 5-3.

Figure 6-4. GPS Menu
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Chapter 7 — Anritsu Tool Box

7-1 Introduction
The Anritsu Tool Box is a suite of applications that provide an interface between Anritsu 
handheld RF instruments and a PC. The instrument connects to the computer via a USB or 
serial port. Depending on the application selected, available functions include the capture, 
transfer, and reporting of measurement data for trace analysis and RF interference analysis.

Tool Box applications are available for download from the Anritsu website at 
anritsu.com/en-US/test-measurement/support/technical-support/handheld-tools-tool-box. 
Click the link to one of the Tool Box applications, then click Downloads and choose either the 
Full Installer or Web Installer. There is no difference between the two if you run the installer 
without saving. If you elect to save, the Full Installer will download all Anritsu software 
needed in a single executable file, which allows you to perform the installation later on a 
computer with no Internet access required. The Web Installer is a much smaller file that will 
require Internet access to execute the software installation.

7-2 Software Installation
Whether running the installer directly or executing the saved file, follow the instructions on 
screen. The Setup screen illustrated in Figure 7-1 may change with the software version.

You will be asked to select which applications you wish to install. Not all instrument models 
are supported by every software tool. To view the list of instrument models supported by a 
Tool Box application, click the Instruments tab on the application Web page. 

Figure 7-1. Anritsu Tool Box Setup Wizard

http://www.anritsu.com/en-US/test-measurement/support/technical-support/handheld-tools-tool-box
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7-3 Anritsu Software Tool Box
The Anritsu Tool Box serves as a central location from which you can open a previously saved 
measurement, visit the Anritsu website, or launch an application. To open the Tool Box, 
either double-click the desktop shortcut or select Anritsu Tool Box from the Windows Start 
menu. On the Tool Box screen, hover the mouse pointer over any of the application icons to 
view a short description of the application. See Figure 7-2. 

Figure 7-2. Anritsu Tool Box Screen
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7-4 Software Tools
The Anritsu Tool Box provides links to the software tools installed on your PC. Alternatively, 
you can launch an application using its desktop shortcut or through the Windows Start menu.

The following sections list the top features and functions of the tools contained in the Anritsu 
Tool Box that are compatible with this instrument model. For a detailed description of these 
features and how to perform specific tasks, refer to each application’s Help system. The 
program Help also lists the instrument models, measurement modes, trace types, and file 
types that are compatible with that application.

Line Sweep Tools (LST)
Line Sweep Tools is post-capture trace processing software designed for users who need to 
analyze and generate reports on large numbers of cable, antenna, and PIM traces. Software 
features include:

• Measurement plot data capture and transfer from the instrument to a PC

• Marker and limit line presets

• Return Loss, Distance-to-Fault, PIM analysis

• LMR Master and VNA Master Field Mode compatibility

• Plot overlay for comparison of up to ten traces of the same measurement type

• Plot area zooming

• A naming grid for renaming files, titles, and subtitles

• Automated report generation

• Output to printer or to PDF or HTML format

• Export of plot data to text, image, or VNA files

Master Software Tools (MST)
Master Software Tools is designed for users of Anritsu handheld spectrum analyzers, 
interference analysis tools, transmission testers, and backhaul testers. Supported functions 
include the following:

• Transfer of captured measurement data to and from a PC for storage and analysis

• RF Spectrum Analyzer traces

• RF Interference analysis

• Spectrum monitoring

• Transmitter signal quality tests

• T1, T3, and E1 backhaul tests

• Trace overlay features for comparing multiple Spectrum Analyzer measurements

• Limit lines and markers

• Script Master for the creation of automated test procedures

• Export of measurement data as text, graphic, or Comma Separated Value format (CSV) 
files

• Reports created in HTML format for use in other applications
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easyTest Tools
easyTest Tools is used to create work instruction files that consist of a command sequence 
and intructions to help less experienced personnel with operating the instrument in the field.

• A drag-and-drop tool facilitates the creation of a test sequence from a library of 
commands.

• Instructions can be a mix of textual prompts and graphic images.

• Sample procedure files (.ett) are included with easyTest Tools.

• Command sequences are delivered electronically and loaded on the instrument, where 
they are recalled with a press of a button.

• Recall Setup places the instrument in the proper mode for the measurement by 
retrieving saved parameters such as measurement type, frequency and amplitude 
settings, markers and limit lines.

• The current measurement setup or the screen display can be saved manually or 
automatically.
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Appendix A — Measurement Guides
A-1 Introduction 
This appendix provides a list of supplemental documentation for Spectrum Master features 
and options. These manuals are available as PDF files on the Anritsu website.

A complete suite of PC Tools for Anritsu Handheld RF Instruments is available for download 
at  anritsu.com/en-US/test-measurement/support/technical-support/handheld-tools-tool-box.

Table A-1. Analyzers and Analyzer Options

Spectrum Master Feature (Required Option)
Related Document 
(Part Number)

All Spectrum Master Instruments

Important Product 
Information, Compliance 
and Safety Notices
(10100-00065)

Spectrum Analyzer
PIM Hunting
Preamplifier (Option 8)
Interference Analyzer (Option 25)
Channel Scanner (Option 27)
EMF Measurements (Option 444)
AM/FM/PM Analyzer (Option 509)

Spectrum Analyzer 
Measurement Guide 
(10580-00349) 
for Firmware AFTER 
V1.11 

High-Accuracy Power Meter (0019)
Power Meter (Option 29)

Power Meter 
Measurement Guide 
(10580-00240)

EMF Measurements (Option 444) EMF Measurement Guide 
(10580-00455)

Performance Specifications Spectrum Master 
Technical Data Sheet 
(11410-00597)

Tracking Generator (Option 20) E-Series Tracking 
Generator 
Measurement Guide
(10580-00339)

SCPI Programming Instruction Spectrum Master 
Programming Manual 
(10580-00256)

Maintenance Manual Spectrum Master 
Maintenance Manual 
(10580-00254)

http://www.anritsu.com/en-US/test-measurement/support/technical-support/handheld-tools-tool-box
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Appendix B — Glossary of Terms

B-1 Introduction
The following terms are related to this product and technology.

B-2 Glossary
3 dB rule : The 3 dB rule provides a means to estimate relative power values. A 3 

dB gain indicates that power increases to twice the power (a multiple of 
2). A 3 dB loss indicates that power decreases to half the power (a 
multiple of 1/2). A system with 40 watts of input power and a 6 dB 
insertion loss will have only 10†watts of output power (a multiple of 1/2 
for each 3 dB loss, or 1/4 of 40 watts). 

 

Adapter : A fitting that supplies a passage between two sets of equipment when 
they cannot be directly interconnected. 

 

Adaptive Array
Antenna : Adaptive array antenna is a type of advanced ’smart’ antenna 

technology that continually monitors a received signal and dynamically 
adapts signal patterns to optimize wireless system performance. The 
arrays use signal processing algorithms to adapt to user movement, to 
changes in the radio-frequency environment, and to multi-path and 
co-channel interference. 

 

ADC : Analog-to-Digital Converter (ADC, A/D or A to D) is an electronic device 
that converts continuous signals to discrete digital numbers. The 
reverse operation is performed by a digital-to-analog converter (DAC). 
ADC can uniquely represent all analog input values within a specified 
total input range by a limited number of digital output codes. Refer also 
to DAC. 

 

Analog System : An Analog system uses an analog transmission method to send voice, 
video and data-using analog signals, such as electricity or sound waves, 
that are continuously variable rather than discreet units as in digital 
transmissions. Mobile analog systems include AMPS, NMT and 
ETACS. 

 

Analog
Transmission : Analog Transmission refers to signals propagated through the medium 

as continuously varying electromagnetic waves. 
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Antenna : Antenna is a device which radiates and/or receives radio signals, 
including RF, microwave, and RADAR. 

 

Antenna
beamwidth : Antenna beamwidth, also known as the half-power beamwidth, is the 

angle of an antenna pattern or beam over which the relative power is at 
or above 50% of the peak power. 

 

Antenna Directivity : Antenna directivity, also known as antenna gain, is the relative gain of 
the main beam of an antenna pattern to a reference antenna, usually an 
isotropic or standard dipole. Antenna Directivity is the percentage of 
radiated signal transmitted or received in a given direction related to 
beamwidth. 

 

Antenna Efficiency : Antenna Efficiency is the percentage of theoretical gain actually 
realized from an antenna. 

 

Antenna Gain : Antenna gain, also known as antenna directivity, is the relative gain of 
the main beam of an antenna pattern to a reference antenna, usually an 
isotropic or standard dipole. Antenna Gain is the effectiveness of a 
directional antenna expressed as the ratio of input power of the 
directional antenna to input power of an isotropic radiator to provide 
the same field strength in the desired direction. Sometimes related to a 
dipole antenna. 

 

Antenna, Isotropic : An isotropic antenna is a theoretical point source radiating a spherical 
power envelope. 

 

Antenna, Parabolic : A parabolic antenna is an antenna utilizing a reflector that is shaped as 
a paraboloid in order to both concentrate the radiated signal into a 
beam and to provide considerable gain. Beamwidth varies inversely and 
gain varies directly with the size of the antenna and with frequency. 

 

Attenuation : Attenuation refers to decreasing in signal magnitude between two 
points. These points may be along a radio path, transmission line or 
other devices. 

 

Attenuator : Attenuator is a device specifically designed to decrease the magnitude 
of a signal transmitted through it. 
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Average power : Average power is the peak power averaged over time and is usually 
applied to pulsed systems where the carrier power is switched on and 
off. 

 

Backhaul : In wireless technology, backhaul refers to transporting voice and data 
traffic from a cell site to the switch. 

 

Band Pass Filter : A Band Pass Filter is a radio wave filter with a specific range of 
frequencies in which it is designed to pass. It rejects frequencies outside 
the pass-band range. A resistor-inductor-capacitor circuit is an example 
of a Band Pass Filter. 

 

Bandwidth : Bandwidth usually identifies the capacity of a circuit or amount of data 
that can be sent through a given circuit. It may be user-specified in a 
PVC. It is an indication of the amount of data that is passing over a 
medium. Also, bandwidth is the portion of the frequency spectrum 
required to transmit desired information. Each radio channel has a 
center frequency and additional frequencies above and below this 
carrier frequency which is used to carry the transmitted information. 
The range of frequencies from the lowest to the highest used is called 
the bandwidth. 

 

BER : Bit Error Rate or Bit Error Ratio (link quality specification/testing) 
(BER) is a measure of transmission quality. The ratio of error bits to the 
total number of bits transmitted. A bit error rate of 10-6 refers to an 
average of one error per million bits. It is generally shown as a negative 
exponent, (for example, 10-7 which means 1 out of 107 bits are in error 
or 1 out of 10,000,000 bits are in error). Bit Error Rate is the fraction of 
a sequence of message bits that are in error. 

 

BERT : Bit Error Rate Test/Tester (BERT) is a test that gauges the quality of 
the T1 or digital line. By sending a known pattern to another device 
across the span, the far end device can compare incoming pattern to its 
own, thereby indicating bit errors on the line. 

 

Broadband : Broadband refers to telecommunication that provides multiple channels 
of data over a single communications medium, typically using some 
form of frequency or wave division multiplexing. It is a service or 
system requiring transmission channels capable of supporting rates 
greater than the Integrated Services Digital Network (ISDN) primary 
rate. 
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Cell Site : Cell Site, also called Base Station, is the local cellular tower and radio 
antenna (including the radios, controller, switch interconnect, etc.) that 
handles communication with subscribers in a particular area or cell. A 
cellular network is made up of many cell sites, all connected back to the 
switch via landline or microwave. 

 

Coaxial Cable : Coaxial Cable (Coax) is a type of electrical communications medium 
used in the LAN environment. This cable consists of an outer conductor 
concentric to an inner conductor, separated from each other by 
insulating material, and covered by some protective outer material. 
This medium offers large bandwidth, supporting high data rates with 
high immunity to electrical interference and a low incidence of errors. 
Coax is subject to distance limitations and is relatively expensive and 
difficult to install. 

 

CPRI : The Common Public Radio Interface (CPRI) is a protocol standard for 
wireless communications that defines the digital interface of radio base 
stations between remote radio heads, also referred to as Radio 
Equipment (RE), and the Radio Equipment Controller (REC). 

 

CW : Continuous Wave (CW) 

 

DANL : Displayed Average Noise Level (DANL): Displayed average noise level 
is sometimes confused with the term Sensitivity. While related, these 
terms have different meanings. Sensitivity is a measure of the 
minimum signal level that yields a defined signal-to-noise ratio (SNR) 
or bit error rate (BER). It is a common metric of radio receiver 
performance. Spectrum analyzer specifications are always given in 
terms of the DANL. One of the primary uses of a spectrum analyzer is to 
search out and measure low-level signals. The limitation in these 
measurements is the noise generated within the spectrum analyzer 
itself. This noise, generated by the random electron motion in various 
circuit elements, is amplified by multiple gain stages in the analyzer 
and appears on the display as a noise signal. On a spectrum analyzer, 
this noise is commonly referred to as the Displayed Average Noise 
Level, or DANL 1. While there are techniques to measure signals 
slightly below the DANL, this noise power ultimately limits our ability 
to make measurements of low-level signals. 
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dB : Decibel or deciBel (dB) is a logarithmic ratio of the difference between 
two values (a logarithm ratio is equal to 10 times). dB is a unit for 
measuring relative power ratios in terms of gain or loss. The units of dB 
are expressed in terms of the logarithm to base 10 of a ratio and 
typically are expressed in watts. For example, a -3 dB loss indicates a 
50% loss in power; a +3 dB reading is a doubling of power; 10 dB 
indicates an increase (or a loss) by a factor of 10; 20 dB indicates an 
increase (or a loss) of a factor of 100; 30 dB indicates an increase (or a 
loss) by a factor of 1000. Common values of dB expressed in ratios: 0 dB 
= 1:1, 10 dB = 10:1, 20 dB = 100:1, 30 dB = 1000:1, -30 dB = 0.001:1 [or 
(1/1000):1]. 

 

dBc : Decibels referenced to the carrier (dBc) is a technique for expressing a 
power measurement in logarithmic form using the carrier power as a 
reference. The units are used to describe how far down signals and noise 
are relative to a known signal. Typical use of this term is to describe 
spurious signals and noise compared to a desired transmit signal. 

 

dBm : dBm is an absolute measurement of power relative to 1 milliwatt. In 
other words, dBm is a decibel value referenced to a milliWatt (dBm). 
This is a technique for expressing a power measurement in logarithmic 
form using 1 mW as a reference. dBm is a decibel ratio (log 10) of Watts 
(W) to one milliwatt (1mW). dBm, therefore, represents absolute power. 
Examples are: 0 dBm = 1.0 milliwatt, 10 dBm = 10 milliwatt, 30 dBm = 
1000 milliwatt = 1 watt. 

 

DHCP : Dynamic Host Configuration Protocol (DHCP) 

 

DSP : Digital Signal Processing (DSP) 

 

EMI : ElectroMagnetic Interface (EMI): EMI refers to signals that are 
generated and radiated by an electronic device and that cause 
interference with radio communications, among other effects. MI is the 
interference by electromagnetic signals that can cause reduced data 
integrity and increased error rates on transmission channels. 

 

FFT : Fast Fourier Transform (FFT) is an efficient algorithm to compute the 
Discrete Fourier transform (DFT) and its inverse. FFTs are of great 
importance to a wide variety of applications, from digital signal 
processing to solving partial differential equations to algorithms for 
quickly multiplying large integers. 
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Flash Memory : Flash memory is a non-volatile solid state storage device that is 
packaged as a chip. It can be electrically erased and reprogrammed. It is 
primarily used in memory cards, USB flash drives, MP3 players, and 
solid-state drives for general storage and transfer of data between 
computers and other digital products. It is a specific type of EEPROM 
(electrically erasable programmable read-only memory) that is erased 
and programmed in large blocks. 

 

Gain : Gain refers to the ratio of the output amplitude of a signal to the input 
amplitude of the signal. This ratio typically is expressed in dB. He 
higher the gain, the better the antenna receives or transmits, but also 
the more noise it includes. 

 

GPS : The Global Positioning System (GPS) is a space-based global navigation 
satellite system (GNSS) that provides reliable location and time 
information in all weather and at all times when and where an 
unobstructed line of sight is available to four or more GPS satellites. 
The system is maintained by the United States government and is 
freely accessible by anyone with a GPS receiver. The Global Positioning 
System is making it possible for people using ground receivers to 
determine their geographic location within 10 meters to 100 meters. 
The satellites use simple mathematical calculations to broadcast 
information that is translated as longitude, latitude, and altitude by 
Earth-based receivers. 

 

Impedance : Impedance is a measure of RF component electrical resistance, 
measured in ohms. In most cable and antenna systems, the standard 
impedance is 50 ohms. 

 

Insertion Loss : Insertion Loss (or Cable Loss) is a measure of the total amount of signal 
energy absorbed (lost) by the cable assembly. It is measured in dB. S21 
(an S-Parameter) is another name for this measurement. 

 

IP Address : An Internet Protocol address (IP address) is usually a numerical label 
that is assigned to each device (computer or printer for example) that is 
participating in a computer network that uses the Internet Protocol for 
communication. An IP address serves two main functions: location 
addressing and host (or network) interface identification. The Internet 
Protocol originally defined an IP address as a 32-bit number. This was 
known as Internet Protocol Version 4 (IPv4), which is still in use. 
Growth of the Internet requires a new addressing system. An Internet 
Protocol Version 6 (IPv6) that uses 128 bits for the address was 
developed in 1995, and it is standardized as RFC 2460. IPv6 began 
being deployed worldwide in the year 2000. IP adresses are binary 
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numbers, but they are usually stored in text files and displayed in 
human-readable notations, such as decimal nnn.nnn.nnn.nnn or 
172.16.255.1 (for IPv4), and hexadecimal 
nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn or 
2C01:AB18:0:1234:FF03:567C:8:1 (for IPv6). In IPv4, each decimal 
group (nnn) represents values from 000 to 255, or binary values of 8 
bits. In IPv6, each hexadecimal group (nnnn) represents values from 
0000 to FFFF, or binary values of 16 bits (0000 0000 0000 0000 to 1111 
1111 1111 1111). 

 

IPv6 : Internet Protocol Version 6 (IPv6) is a numerical label that is used to 
identify a network interface of a computer or other network node 
participating in an IPV6-enabled computer network. IPv6 uses 128 bits 
for the address (as compared to an IPv4 address, which is defined as a 
32-bit number). Pv6 was developed in 1995, and it is standardized as 
RFC 2460. V6 began being deployed worldwide in the year 2000. I 
addresses are binary numbers, but they are usually stored in text files 
and displayed in human-readable notations, such as hexadecimal 
nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn or 
2C01:AB18:0:1234:FF03:567C:8:1 (where FFFF [Hex] = 65535 [Dec]). 
Ea hexadecimal group (nnnn) represents values from 0000 to†FFFF, or 
binary values of 16 bits (0000 0000 0000 0000 to 1111 1111 1111 1111). 

 

NF : Noise Figure (NF) is a measure of degradation of the signal-to-noise 
ratio (SNR) that is caused by components in a radio frequency (RF) 
device. The noise factor (F) of a system is defined as the signal-to-noise 
ratio of the input power of the system divided by the signal-to-noise 
ratio of the output power of that system. F (the noise figure) is defined 
as the decibel value of the noise factor. NF = 10log (F) where log uses 
the base 10, or common log. This formula is valid only then the input 
termination is at standard noise temperature. 

 

OBSAI : The Open Base Station Architecture Initiative (OBSAI) specifications 
define a set of requirements for a wireless base transceiver station 
(BTS). Reference Point 3 (RP3) within the OBSAI specifications defines 
the digital interface between the Base Band Module (BBM) and the 
Radio Frequency Module (RFM). This is an alternative to the 
traditional Radio Frequency (RF) coaxial connection, or the CPRI 
digital interface. 

 

OBW : Occupied Bandwidth (OBW) is a measure of the bandwidth containing 
99% of the total integrated power of the transmitted spectrum, centered 
on the assigned channel frequency. Interference to other channels or to 
other systems can occur if OBW is too large. 
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OTA : Over The Air (OTA): OTA refers generally to any transfer of information 
or signal that takes place in a wireless environment, rather than using 
a wired connection. OTA is usually used in connection with a standard 
defining the provisioning of mobile devices and applications, such as 
downloading or uploading content or software, and commonly used in 
conjunction with the Short Messaging Service (SMS). SMS OTA 
Messages contain information that is used to configure the settings of a 
WAP browser in a mobile phone (refer to SMS and WAP). 

 

Return Loss : Return Loss is a measurement (in dB) of reflected energy caused by 
impedance mismatch. May also be referred to as S11. Although S11 
values are expressed as negative numbers, Return Loss values are 
expressed as positive numbers because by definition the ìLossî 
expression implies a negative sign. The higher the value, the better the 
impedance match (think of a large negative number being less than a 
smaller negative number). 40 dB is nearly ideal. Only 0.01 % of the total 
transmitted power is reflected if the Return Loss measurement value is 
40 dB. A measured value of 0 dB would be a complete reflection, or 
stated another way, 100 % of the transmitted power is reflected back. 
Return Loss is typically a pass/fail measurement. 

 

RF : Radio Frequency (RF) is the frequency of radio sine waves. RF generally 
refers to wireless communications within a frequency range of 3 kHz to 
300 GHz. Formally, according to the Article 2 of the Radio Law, radio 
frequency is below 3,000 GHz. Radio frequencies can be used for 
communications between a mobile telephone and an antenna mast. 

 

SCPI : Standard Commands for Programmable Instruments (SCPI) 

 

Watt : Watt (W) is a unit of measure for power. 
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